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Here comes the abstract (about 100 words or less) of the paper. (For your reference, the abstract given here contains exactly 100 words.) This document explains the stylistic specifications for manuscripts submitted to Interdisciplinary Studies on Information Structure: Working Papers of SFB632 (ISIS). Please read it through and follow the guideline. This document is created using all the preset styles required for the volumes. Please use this document as a template. Make a copy of this file, delete the content, and start writing your work using the preset styles. Or paste what you have written elsewhere and change the styles.

Keywords: AAA, BBB, CCC, DDD, EEE …

1 Introduction

This document describes the style requirements for manuscripts submitted to Interdisciplinary Study on Information Structure: Working Papers of the SFB 632 (ISIS). All manuscripts must be submitted as a MicrosoftWord file (.doc) or as a LaTeX file (.tex). Please use the Word/LaTeX template file to comply all the requirements. The template file contains all the preset styles necessary for the manuscript, and all the settings are correctly set. If one cannot submit a manuscript with either of these formats, please contact to the volume editor(s).

2 Page Setup

Document size is A4 (Do not use Letter size!). Select “Page setup…” from “File” menu to set the document size. Submitted manuscripts are reduced about 30% when they are printed, in order to fit to A5 size.

3 Paragraph Setting and Preset Styles

In this document, all the necessary styles are provided as preset styles. The following is the list of preset styles for ISIS:

• Normal—for main text

• Heading 1—for main section headings

• Heading 2—for subsection headings

• Heading 3—for sub-subsection headings

• Heading 4—for non-numbered headings

• Heading Ref/Appendix—for the headings for References and Appendices

• Title—for the paper title

• Author—for author’s name(s)

• Affiliation—for author’s affiliation(s)

• Abstract—for abstract

• Keyword—for keywords

• Example—for example sentences

• Example-ab—for example sentences with sublabels (a, b, …)

• Tableaux—for OT tableaux

• Header—for header text

• Footer—for footer text

• Footnote Text—for footnote text

• Footnote Example—for examples in footnotes

• Footnote Example-ab—for examples with sublabels (a, b, …) in footnotes
• Reference Text—for reference text

• Contact Info—for contact info

Please use them wherever appropriate.

4 Document Setup

If you are using this document as a template, the following settings are already made. It is therefore unnecessary to set them up.

Select “Document…” from “Format” menu and set margins as follows: Top: 3.5cm, Bottom: 2.5cm, Left/Right: 2.5cm, Gutter: 0cm, Header/Footer: 2.5cm. In the “Layout” tab, choose the section start “Odd page”, turn on the two Headers & Footers options: “Different First Page” and “Different Odd and Even”. Also, click “Borders…” button, turn on the top borderline with the following settings: Line width 1/2pt, apply to “All except first page,” uncheck “surround header” option (from “Options…” button), Top margin 6pt.

5 Main Text/Footnotes

The preset styles for main and footnote texts are “Normal” and “Footnote Text”, respectively. For the main text, font is Times New Roman, 14pt, and 1.5 line-spaced. As mentioned above, manuscripts will be reduced to A5 size when they are printed.


The first paragraph after section headings starts without an indentation, as in the paragraph above. From the second paragraph and thereafter (like this one and the following one), insert one tab to start the paragraphs.


Footnotes are 12pt and single-spaced. Insert one tab at the beginning of the text so that the left side of the footnote text is properly aligned. An example is given below.

6 Section Headings

There are in principle three levels of section headings: Sections, subsections, and sub-subsections. Do not use any deeper levels of headings. We recommend that authors use only top two levels (sections and subsections). The preset style for the main section headings (“Heading 1”) is: 14pt, boldface, “space before,” 24pt, “space after,” 6pt.


Subsection & sub-subsection headings look like the following:

6.1 Example of subsection

Subjection headings (“Heading 2”) are 14pt, boldface, “space before,” 12pt, “space after” 6pt.

6.1.1 Example of sub-subsection

Sub-subsection headings (“Heading 3”) are 14pt, italic, “space before,” 6pt, “space after,” 6pt.


In case you really need more heading options, a non-numbered heading (“Heading 4”) is also available. The style setting is the same as sub-subsections, except that it does not have automatic numbering. Following is an example:

Example of non-numbered heading

Non-numbered headings (“Heading 4”) are 14pt, italic, “space before,” 6pt, “space after,” 6pt.


For the first three preset styles (“Heading 1–3”), automatic numbering is used. Section number starts from 1, not from 0. “Heading 4” is not numbered. Use title capitalization (Capitalize All but Function Words) for section headings (“Heading 1” and “Heading Ref/Appendix”), and sentence capitalization (Capitalize only the first word, as well as the one following a colon) for the lower heading levels (“Heading 2–4”).

7 Examples

There are two preset styles for example sentences. One is for examples with only example numbers.  The other is for examples with sublabels (a, b, …).


Example sentences without sublabels look like the following.

(1)

Taro-ga


Hanako-ni


ringo-o



age-ta
Taro-nom
Hanako-dat

apple-acc
give-pst
‘Taro gave an apple to Hanako.’

(2)
*
Taro-ga


Hanako-ni


ringo-o



tabe-ta
Taro-nom
Hanako-dat

apple-acc
eat-pst
‘Taro ate an apple to Hanako.’

[Insert one empty line with the ‘Normal’ style.]

Examples are single-spaced. Use SmallCaps for gloss abbreviations (-nom, -acc, -pst, etc.). The preset style for them is “Example”. After the example number (e.g., (1), (33), etc.), use one tab (1.25cm, right-aligned) to move to a position for judgment status (*, ?, ??, etc.). Type another tab (1.5cm, left-aligned) to move to the start of the example sentence. If a sentence is grammatical and no judgment status mark is needed, type two tabs and start the sentence. Use tabs to separate each word in examples. Do not use spaces. After the second tab position (i.e., the beginning of example sentences), each tab moves the cursor every 0.25 cm. Use appropriate number of tabs to separate each word, and to left-align glosses to each word. At the end of each example sentence, use SHIFT+RETRURN to move on to the following lines (gloss and/or the translation), so that each example (with gloss and translation) will become a single paragraph. After the translation line, insert one empty line with the ‘Normal’ style, then start the paragraph. (NB: You need no empty line before the examples.)
For examples with sublabels (a, b, …), use the preset style “Example-ab,” which has a different tab settings from “Example”.

(2)
a.

Taro-ga


Hanako-ni


ringo-o



age-ta
Taro-nom
Hanako-dat

apple-acc
give-pst
‘Taro gave an apple to Hanako.’


b.
*
Taro-ga


Hanako-ni


ringo-o



tabe-ta
Taro-nom
Hanako-dat

ringo-acc
eat-pst
‘Taro ate an apple to Hanako.’

[Insert one empty line with the ‘Normal’ style.]

The first tab position (1cm) is for the sublabels (a, b, …), the second (1.75, right-aligned) for judgments, and the third (2cm) and thereafter (0.25cm each) is for words in examples.


For examples in footnotes, use the styles named “Footnote Example” and “Footnote Example-ab”. Their formats basically follow those of “Example” and “Example-ab”, respectively. See the examples.


Turn off the “Tabs and backspaces set left indent” option in the preference (“Preference…”(“Edit” tab). It will screw up the preset styles settings. It is also advisable to turn off the “Automatic numbered list” option of the “AutoCorrect” function (“Tools”(“AutoCorrect…”(“AutoFormat As You Type” tab).


There is no automatic example numbering in this template. Make sure that example numbers are correct throughout. We do not recommend the use of any macro for automatic numbering, because they often make documents more fragile.

8 Trees

Trees can be written using Arboreal font, or the drawing program in Word. If there is anything to be written by hand, make sure to notify the editor(s) when you submit the manuscript, so that they will not miss them when they reprint it.

9 Tableaux

Use table tool in Word to draw OT Tableaux. Each table follows the example number, as shown below:

(3)
Tableaux Example

	
	
	/root/
	Constraint 1
	Constraint 2
	Constraint 3

	(
	a.
	Candidate 1
	
	
	*

	
	b.
	Candidate 2
	
	*!
	

	
	c.
	Candidate 3
	*!
	
	


We do not require any specific format for the tableaux. In the example above, the following settings are used: “Example-ab” style for the first line (i.e., the line with the example number), “Tableaux” preset style for the table (single-space, centered), left-aligned for the second column (labels: a., b., c.), no lines between the first (“pointing finger”) and the second column (a., b., c.), also between and the second and the third (candidates) column, Shading 30% gray, Text wrapping (“Table”(“Table Properties”(“Positioning…”), Horizontal position 1cm, relative to column, left/right 10cm, “move with text” option, checked.

10 Graphics, Tables, etc.

Make sure that the inserted graphics and tables are large enough so that they are easily readable after the manuscript is reduced to A5 paper size.

11 Miscellaneous

Use ‘en-dashes’ (–) between numbers such as page numbers in the reference (e.g., p. 100–102), example numbers (e.g., (10)–(12)), instead of normal hyphens. Use ‘em-dashes’ (—) to set of the text, either without spaces—like this—or with spaces — like this — but please do so consistently. You can use either single or double space after period, but please do so consistently. You may use curly quotes “…”/‘…’ or non-curly ones "…"/'…' at your choice, but use it consistently. Follow traditional publishers’ guidelines for punctuation and other stylistic conventions, e.g., quotations. In any case, make sure you follow the guideline consistently.

12 Appendix, References, and Contact Information

After the main text, Appendices may be added. They will be followed by the list of references and the contact information of the author(s).


Headings for the reference and appendices are not numbered. The preset style is named “Heading Ref/Appendix”. The style format of “Heading Ref/Appendix” is exactly the same as that of “Heading 1”, except that the former is not numbered.


The preset style for the reference text is “Reference Text”. The settings are the same with “Normal” except: Single-space, hanging 1.27cm. We leave up to authors for the styles of reference, but please make sure they are correct and consistent. The references are single-spaced.


At the end of the paper (i.e., after references), write down author(s)’s contact information (Name, postal address, e-mail address, website URL). Use the preset style “Contact Info,” which is set as follows: Single-space, italic, left-aligned, “space before” 24pt, “Keep lines together” option on. Use SHIFT+RETURN to move to the next line (just in the same way as in the “Example” style), so that the entire contact information becomes one paragraph.


See the example of appendix, reference, and contact information.

Appendix: List of Preset Style Settings
	Preset style name
	Specifications

	Normal
	Font: Times New Roman, 14pt, Line-spacing: 1.5 lines, Justified

	Heading 1
	Font: 14pt, boldface, Space Before: 24pt, Space After: 6pt, numbered (1, 2, 3, …)

	Heading 2
	Font: 14pt, boldface, Space Before: 12pt Space After: 3pt, numbered (1.1, 1.2, 1.3, …)

	Heading 3
	Font: 14pt, boldface, Space Before: 6pt Space After: 3pt, numbered (1.1.1, 1.1.2, 1.1.3, …)

	Heading 4
	(Same as Heading 3, but non-numbered)

	Heading Ref/Appendix
	(Same as Heading 1, but non-numbered)

	Title
	Font: 16pt, Bold, Centered, Line-spacing: single, Space After: 3pt

	Author
	(Normal +) Font: italic, Centered, Line-spacing: single, Space Before: 18pt

	Affiliation
	(Normal +) Centered, Line-spacing: single, Space Before: 6pt

	Abstract
	(Normal +) Font: 12pt, Indent: Left: 2cm, Right: 2cm, Line-spacing: single, Space Before: 24pt

	Keyword
	(Abstract +) Font: italic, Space Before: 12pt, Space After: 24pt

	Example
	Left-aligned, Line-spacing: single, Hanging: 1.5cm, Space Before: 18pt, Tabs: 1.25cm (Left aligned), 1.25cm (Right), 1.75cm (Left), +0.25cm (Left) thereafter

	Example-ab
	(same as Example except) Hanging: 1.75cm, Tabs: 1cm (Left), 1.75cm (Right), 2cm (Left)

	Tableaux
	(Normal +) Centered, Line-spacing: single, Position: Holizontal 1cm, Relative to column, Holizontal: 1cm, Vertical: 0cm, Relative to paragraph, Wrap around

	Header
	Font: 12pt

	Footer
	Font: 12pt, Line-spacing: single

	Footnote Text
	(Normal +) Font: 12pt, Hanging 0.5 cm, Line-spacing: single

	Footnote Example
	(Footnote Text +) Space Before: 12pt, Indent: 0.5cm, Hanging: 1.5cm, Tabs: 1.25cm (Left), 2cm (Right), 2.25 (Left), +0.25 (Left) thereafter

	Footnote Example-ab
	(same as Footnote Text except) Hanging: 1.75cm, Tabs: 1cm (Left), 1.75cm (Right), 2cm (Left)

	Reference Text
	(Normal +) Indent: 0cm, Hanging 1cm, Line spacing: single, Space After: 12pt

	Contact Info
	(Normal +) Font: italic, Line-spacing: single, Left aligned, Space Before: 24pt


Reference

Jackendoff, Ray. 1972. Semantic Interpretation in Generative Grammar. Cambridge, MA: MIT Press.

Rooth, Mats. 1985. Association with Focus. Doctoral Dissertation, University of Massachusetts, Amherst.

Selkirk, Elisabeth O. (1995). Sentence prosody: Intonation, stress and phrasing. In Handbook of phonological theory, ed. John Goldsmith, 550–569. Cambridge, MA: Blackwell.
Shinichiro Ishihara
Universität Potsdam
SFB 632 „Informationsstruktur“
Postfach 601553
14415 Potsdam
Germany
ishihara@rz.uni-potsdam.de
http://alum.mit.edu/www/s_i/

*	Here comes the Acknowledgement. Many thanks to AA, BB, CC, DD, EE, FF, and GG for their valuable comments and discussion … and so on.


� 	An example of footnote. Insert one tab at the beginning of each footnote to align the left side of the footnote text.


� 	This is an example of the “Footnote Example”.


(i)	*	Taro-ga			Hanako-ni			ringo-o				age-ta�Taro-NOM	Hanako-DAT	apple-ACC	give-PST�Taro gave an apple to Hanako.’


	[Insert one empty line with the ‘Footnote Text’ style.]


	This is an example of “Footnote Example-ab”.


(ii)	a.		Taro-ga			Hanako-ni			ringo-o				age-ta�Taro-NOM	Hanako-DAT	apple-ACC	give-PST�‘Taro gave an apple to Hanako.’


	b.	*	Taro-ga			Hanako-ni			ringo-o				tabe-ta�Taro-NOM	Hanako-DAT	ringo-ACC	eat-PST�‘Taro ate an apple to Hanako.’


	[Insert one empty line with the ‘Footnote Text’ style.]


	The usage of these styles is basically the same as “Example” and “Example-ab” for the main text.
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